
 

Getting Started with Fusion 360 
Jo-Ann Hogan – Modena Design Centres   

SB5231 - This class will serve as an introduction to the Fusion 360 3D CAD design app, covering typical 

processes and workflows. Gain a clear understanding of the user interface, commands, and functionality. 
Additionally, learn about the fundamentals necessary to bring the Fusion 360 app into your work 
environment, and get started designing products differently. 

Learning Objectives 
At the end of this class, you will be able to: 

 Discover key aspects in getting started with the Fusion 360 app 

 Learn how to use the base tools and commands in the Fusion 360 app 

 Share and collaborate designs 

 Learn how to create and publish conceptual models 

 

About the Speaker 

Jo-Ann Hogan is known for keeping her training lively and enjoyable. She has over 5 years of 

experience involving production drafting in the mining and engineering industry. She also has 2 

years of experience providing user support and training for various Autodesk CAD applications. A 

few of the applications she works with daily are AutoCAD software, Inventor software, Revit 

software, 3ds Max software, and the Fusion 360 3D CAD design app. She continues to be actively 

involved in product shoreline testing, as well as in discussion groups, Autodesk Community, and 

Modena Design Centre's User Group. She presented at Autodesk University for Johannesburg in 

2012 and 2013, and she has also participated and presented at numerous company events. 

Jo-ann@modena.co.za  
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1. Discover Key Aspects of Getting Started with the Fusion 360 app. 

1.1 DOWNLOAD THE SOFTWARE 

1.1.1 30 Day Trial 

 You can use the Fusion 360 Trial for up to 30 days 

 With the trial version you will still have the full use of Fusion 360 

 You do not need to insert your credit card details to download the trial version 

 You will receive In-Product training and support 

 Fusion 360 is available in English 

 You can download Fusion 360 on 64-Bit Mac or Windows operating systems 

 After your trial expires you will still have access to your designs through your Fusion 360 

account 

 Here is the link where you can Download your Fusion 360 Free Trial: 

http://www.appstreaming.autodesk.com/install/app/73e72ada57b7480280f7a6f4a289729

f/ 

1.1.2 Buy Fusion 360 for Commercial Use 

 You have flexible and affordable pricing options that would meet your needs 

 You can choose to pay Monthly, Quarterly or Annually 

 Here is the link where you can Buy Fusion 360 with the different pricing options: 

http://fusion360.autodesk.com/pricing# 

1.1.3 Get Fusion 360 Free for Non-Commercial Use 

 Fusion 360 is free for the Educational Community and for users that is still starting up with 

Fusion 360 and not using Fusion 360 for commercial use. 

 You can use the link in 1.2 to see if you qualify for the free version of Fusion 360. 

1.2 ACCESS YOUR FUSION 360 ACCOUNT 

1.2.1 Sign into your Fusion 360 Account Online 

 You can sign into Fusion 360 online to Share and Collaborate designs with the Fusion 360 

community and explore the other designer’s models. 

 In Fusion 360 Online you are able to start discussions on issues you are experiencing or 

ask your community for some help. 

 Sign into Fusion 360 using your Autodesk ID and Password 

 Here is a link where you can access Fusion 360 Online: http://fusion360.autodesk.com/ 

http://www.appstreaming.autodesk.com/install/app/73e72ada57b7480280f7a6f4a289729f/
http://www.appstreaming.autodesk.com/install/app/73e72ada57b7480280f7a6f4a289729f/
http://fusion360.autodesk.com/pricing
http://fusion360.autodesk.com/
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1.2.2 Sign into your Fusion 360 Application 

 Once you open your Fusion 360 Application that you have installed, it will ask you to sign 

into your account. You can use your Autodesk ID and password to sign into your Fusion 

360 account.  

 If you do not have an Autodesk ID please see 1.2.3. 
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1.2.3 Need an Autodesk ID? 

 If you do not have an Autodesk ID yet, you can easily create an Autodesk ID online at 

https://accounts.autodesk.com/register or alternatively select “Create an Account” and fill in 

the relevant form. 

 An Autodesk account is free of charge and you will only be charged for certain services. 

You will get a certain amount of cloud credits per year and if those credits have run out, you 

have an option to purchase more credits. 

 You will use cloud credits for services like: Rendering in the cloud, Autodesk Sim 360, 

Autodesk Simulation Flex, Autodesk Infraworks 360, Structural Analysis for Revit, 

Optimization for Inventor, Configurator 360 and Lighting Analysis for Revit. You can read 

more about cloud credits here: http://knowledge.autodesk.com/support/autodesk-

360/troubleshooting/caas/sfdcarticles/sfdcarticles/Autodesk-360-Cloud-Credits-FAQs.html 

 

 

 

 

  

https://accounts.autodesk.com/register
http://knowledge.autodesk.com/support/autodesk-360/troubleshooting/caas/sfdcarticles/sfdcarticles/Autodesk-360-Cloud-Credits-FAQs.html
http://knowledge.autodesk.com/support/autodesk-360/troubleshooting/caas/sfdcarticles/sfdcarticles/Autodesk-360-Cloud-Credits-FAQs.html
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1.3 FUSION 360 USER INTERFACE 

 

 

1.3.1 Data Panel: 

 The Data Panel is where you will access your projects, open your 

designs and upload designs to your project. 

1.3.2 File Pull-Down Menu: 

 The File pull-down menu is where you will create a new design, new 

toolpaths or drawings.  

 You can save, export and even 3D print from the File pull-down menu 

1.3.3 Save, Undo and Redo: 

 Save – will save the changes made to your design. Shortcut: 

<CTRL>+S 

 Undo – Will undo or remove the last change you made in your design. 

Shortcut: <CTRL>+Z 

 Redo – If you performed an undo and you want to go back to the 

previous step, you will use redo to recreate the changes you have just 

removed or undid. Shortcut: <CTRL>+Y 

1.3.4 User Profile: 

 In the User Profile drop down you can access your account, profile and user preferences. 
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 You can toggle online and offline mode, which will allow you to use Fusion even if you are 

not connected to the Internet. 

1.3.5 Help Pull-Down Menu: 

 You can search for help or simply browse through the help options.  

 The Help pull-down menu will give you access to your what’s new features and In-Product 

Tutorials 

1.3.6 Tabs: 

 When you have more than one design open, you will see the different design tabs appear 

at the top of your screen. This allows you to Navigate and close between your different 

designs 

 

 

1.3.7 Toolbar: 

 The Toolbar gives you access to the different design commands. 

 When you select the dropdown menu, if will give you additional commands relevant to the 

category.  

 You can use the arrow next to the command to add it to the Toolbar, and if the command is 

already added, you can use the “X” to remove the command from the Toolbar. 

 

1.3.8 Marking Menu: 

 You can access the Marking Menu by right-clicking in the canvas. 

 You will find the most commonly used commands in the Marking 

Menu and below the Marking Menu you will find a list of all the 

commands for the particular workspace. 

 The Marking Menu is context specific so you will see different 

commands depending of your environment or is a command is 

active. 
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1.3.9 Workspace Switcher: 

 

 You will use the Workspace Switcher to select which workspace to be 

active. This will control the commands in the Toolbar as well as the type of 

geometry that is created. 

 For example – the render workspace allows you to create renders of your 

design and the sculpting workspace will allow you to create organic or 

curved designs. 

 

 

 

1.3.10 Browser: 

 The browser will list all the objects that are part of 

the design. 

 If you have an assembly design open, the browser 

will display several components which is individual 

objects in your design. 

 

 

1.3.11 Activity Feed: 

 Your activity feed allows you to collaborate your design with other 

designers. 

 You can add messages to the design, take a quick screen capture 

and post that to the cloud so you can collaborate. 

 

 

 

 

1.3.12 Timeline: 

 The timeline contains all the operations used in the design. 

 On the left hand side of the timeline you will find playback 

controls so you can roll back to the beginning of your design, 

click play and see how this design was created. 

 You have the option to step back in your timeline through the individual operations as well 

as drag the design marker to different stages in the operation, just to see how the design 

was created. 

 You can use the timeline to edit the different operations by right-clicking on the operation. 

You can change the operation size or function. 

 



Getting Started with Fusion 360 

Jo-Ann Hogan – jo-ann@modena.co.za  9 

1.3.13 Navigation Bar: 

 The navigation bar gives you the different navigation tools such as Zoom, Pan and Rotate. 

 Another way to navigate in your drawing is using the View Cube. You can drag to orbit the 

model or click on one of the view cube’s faces, edges or corners to snap to a specific view. 

 A quicker way to navigate through your design will be using a Track Pad (for Mac) or the 

mouse  

o Zoom – Scroll the mouse wheel 

o Pan – Hold the mouse wheel down 

o Orbit – Use <SHIFT> and hold the mouse wheel 

 The navigation bar also contains a few display settings and tools 

o Visual Styles 

o Background lighting 

o Effects 

o Object Visibility 

o Camera 

 The Layout Grid allows you to turn the grid on or off, snap to the grid and set the snap values 

for the grid. 
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2. Learn How to Use the Base Tools and Commands in the Fusion 360 app. 
There are 4 different environments in Fusion 360. Model, Sculpt, Patch and Render. In the next 

section I will show you the different environments and tools in order to create your different models. 

The exercises are using metric units. You are able to change your units by going to your User 

Profile dropdown and selecting Preferences. You can change the units in the “Default Units” sub 

tab. 

2.1 MODEL ENVIRONMENT 

2.1.1 How to create a basic design in the model environment 

Tools used in this section: Cylinder, Fillet, Press Pull, Sketch, and Offset 

Creating the Base 
o Start the cylinder command in the create 

dropdown. 
o Choose the plane where you want to start the 

sketch 
o Specify a centre point, diameter and height for your 

sketch 
o Diameter (350 mm) Height (80 mm) 
o Creating a fillet: Start the press pull command, select the edge of the 

model and specify a radius (30 mm) 
 

Creating the Neck 
o Create sketch and select left work plane 

 
o Select Project geometry from the sketch drop down and select the top edge of the cylinder 
o Change the view cube to the “Right” view 
o Start the line command and draw the shape of the neck 

 

 
 

o Select press pull and extrude this shape to create the neck 
o Distance (45 mm) Direction (Symmetric) Operation (New Body) 
o Create an offset: Start the offset command and select the face there you want to create the 

offset, select the edge you want to offset and specify the distance. 
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o Start the Press pull command and create the cut in the body. 
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o Create fillet using the fillet command: Select edge and specify 
the radius.  
Radius 1 (15 mm) Radius 2 (10 mm) 
 

o Creating a fillet: Start the press pull command, select the edge of 
the model and specify a radius (30 mm) 
 

 
 
 
 
 
 
 
 

 

2.1.2 Additional Material Available for the Model Environment 

 Mechanical Design 1 

 Mechanical Design 2 

 Mechanical Design 3 

 Mechanical Design 4 

2.2 SCULPT ENVIRONMENT 

2.2.1 How to create a freeform lamp shade in the Sculpt Environment 

Tools used in this section: Look At, Cylinder, Edit Form, Manipulator Handles, Thicken. 
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Creating the Lamp Shade 

o Use the “Look At” command to look at the bottom face of the neck. 
 

 
 

o In the  create panel, select the “create form” command this will take you to the sculpt 
environment. 
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o Start your Cylinder command in the create panel and 
select the face of the neck. Diameter: (65 mm) Height: 
(125 mm) 

o Use the View Cube to rotate the view. 
o Double click on the second edge from the top to select the 

loop of the edge. 
o Right click anywhere in the graphics window and select 

“Edit Form” (You will also find edit form in the Modify drop 
down.) 

o Use the manipulator handles to create the shape of the 
lamp shade. 

o Select “finish form” in the toolbar to finish your shape. 
 
 
 

o Use the “thicken” command to make your surface a solid and give it some thickness. 
o To make changes in your models, right click on the sculpted body in the timeline and select 

“edit”. Use the “finish form” command to finish after you have made your changes.  
 

 
 

2.2.2 Additional Material Available for the Sculpt Environment 

 Sculpt Design – Hairdryer 

 Sculpt Design – Handle 

 Sculpt Design – Couch 

 
 
 



Getting Started with Fusion 360 

Jo-Ann Hogan – jo-ann@modena.co.za  15 

2.3 PATCH ENVIRONMENT 

The patch environment allows you to create models with different surfaces.  

2.3.1 How to create a toy car core cavity mold in the patch environment. 

Create the Toy Car Sketches 

1. Create a sketch on the XZ plane and name the sketch “Front 

Profile Sketch” 

 

2. Create a plane using the “Plane along path” found in the 

“Construct” dropdown. Name the plane “Front Sweep 

Workplane” 

 

 
 

3. Create a sketch on the new workplane. Use “Project 

Geometry” to reuse the points. Name the sketch “Front_Sweep 

Path Sketch” 

 

4. Create a sketch on the XZ plane. Use “Project geometry” to 

project the points. Name the sketch “Rear Profile Sketch”. 
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5. Create a plane using the “Plane along Path” command. Name the plane “Rear Sweep 

Workplane” 

 
6. Create a sketch on the new plane and name it “Rear Sweep Path Sketch” 

 
7. Create a sketch on the XZ plane and name the sketch “Side Profile Sketch” 
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8. Create a plane using the “Plane Along Path” and 

name it “Side Sweep Path Workplane” 

 

9. Create a sketch on the new plane and name it 

“Side Sweep Path Sketch” 

 
10. Create a plane using the “Offset Plane”. Offset the plane from the YZ plane  

-240mm. Name the plane “Grill Workplane” 
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11. Create a sketch on the new workplane and name it 

“Grill Spline” 

12. Create a plane using the “Offset Plane” command. 

Offset the plane from the YZ plane  

-86mm. Name the workplane “Front Quarter Panel 

Workplane” 

13. Create a sketch on the new plane and name it “Front 

Quarter Panel Spline” 

 

 

 

14. Create a plane using the “Offset Plane” option. Offset the plane from the YZ plane 88mm. 

Name the plane “Rear Quarter Panel Workplane” 

 

15. Create a sketch on the new plane and name it “Rear Quarter Panel Spline” 

 

 

 
16. Create a plane using the “Offset Plane” command. Offset the plane from the YZ plane 

260mm. Name the plane “Tail Workplane” 
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17. Create a sketch on the new plane and name it “Tail Spline” 

 
 

 

 

18. Create a sketch on the XZ plane. Use “Project 

Geometry” to reuse the points. Name the 

sketch “Tooling Sketch” 

 

19. Create a sketch on the XZ plane and name 

the sketch “Canopy” 
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20. Create a sketch on the XY plane and name the sketch “Canopy Sweep Path” 

 
21. Create a sketch on the XY plane and name the sketch “Wheel Wells Sketch” 

 
22. Create a sketch on the XZ plane and name the sketch “Mounting Post Sketch” 
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23. Hide ALL the sketches and planes. 

Create the Toy Car Surfaces 

24. Go to the “Create Form” command and enter the sculpt 

environment. 

25. Turn ON the visibility of the “Front Profile Sketch” and “Front 

Sweep Path Sketch”. Create a sweep between the profile 

and the path sketch. 

 
26. Turn OFF the visibility of the “Front Profile Sketch” and “Front Sweep Path Sketch”. Turn 

ON the visibility of the “Rear Profile Sketch” and “Rear Sweep Path Sketch”. Create a sweep 

between the profile and the path sketch. 
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27. Turn OFF the visibility of the “Rear Profile Sketch” and 

“Rear Sweep Path Sketch”. Turn ON the visibility of the 

“Side Profile Sketch” and “Side Sweep Path Sketch”. 

Create a sweep between the profile and the path 

sketch. Mirror the profile along the XY plane. 

 

28. Turn OFF the visibility of the “Side Profile Sketch” and 

“Side Sweep Path Sketch”. Turn ON the visibility of the 

Grill Spline, Front and Rear Quarter Panel and the Tail 

Spline. Loft the sketches in order. (Take care: Select the 

curves on approximately the same location and not on 

the points.) 

 

Create the Toy Car Solid 

29. Start the “Boundary Fill” command. Select the five surfaces that we have created and XZ 

plane for the “Selection Tools”. Select the enclosed volume for the “Select Cells” option as 

indicated below. 

 
30. Hide all the surface bodies. 

31. Turn ON the visibility of the “Canopy” and “Canopy Sweep Path”. Create a sweep between 

the profile and the path sketches. Make sure the sweep is set to Join and not cut. 

 
 

 

32. Select the two front corners as shown for the fillet and set the radius to 80mm. 
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33. Select the edges as shown and set the fillet radius to 20mm. 

 
34. Create a fillet on the edge as shown below with a radius of 4mm. 

 
35. “Right-click” on the solid body in the browser and select “Copy”. “Right-click” again and 

select “Paste”. Rename the first solid as “Toy Car” and hide the body. Rename the second 

solid as “Core Toolbody”. 

 

 

36. Turn ON the visibility of the “Tooling Sketch”. 

Extrude the sketch down a distance of 50mm, 

joined to the core toolbody. 
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37. Turn ON the visibility of the “Wheel Well Sketch”. Extrude the circles “Two sides” using the 

join option. Set both distances to 110mm. 

 
38. Turn ON the visibility of the “Tooling Sketch”. Extrude the sketch up by a distance of 120mm. 

Make double sure that you choose the “New Body” option. Hide the tooling sketch. Name 

the new body “Mold Cavity” 

 
39. “Right-click” on the Core Toolbody, select copy and paste. Rename the new body as 

“Cavity Toolbody”. You should have four solid bodies in your browser. Hide the core 

toolbody. 

40. Select the “Combine” command in the “Modify” tab. select the “Mold Cavity” as the Target 

Body and the “Cavity Toolbody” as the tool bodies. Set the operation to “Cut”. Hide the “Mold 

Cavity” and show the “Toy Car Body”  

 

 

 

41. Shell the Toy Car Body, removing the face with an 

inside thickness of 2mm. 
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42. Turn ON the visibility of the “Wheel Wells Sketch”. 

Extrude the sketch to cut through both sides. Turn 

OFF the sketch after the extrusion. 

 

43. ALWAYS remember to save your model. 

 

 

2.3.2 Additional Material for the Patch Environment 

 Patch Environment – Twisted Vase 

 Patch Environment – Bottle 

2.4 RENDER ENVIRONMENT 

The render environment allows you to create photorealistic images from the model that you have 
created.  

2.4.1 How to create a photorealistic image using the Render Commands. 

o In the Workspace drop down, select the Render Environment. 

 
 
o To apply materials to your model, select the “Appearance” command 
o Browse to the material you want to use and apply it to your object using a simple drag and 

drop method. 
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o To set your environment settings like your shadow display, select your “Environment” 
command. 

 
 

o Select “Render” to start your Rapid Ray Tracing. 
 

 
 

o You get 3 different types of rendering qualities: Quick, Normal and Advanced. 
 
 Quick: Will create a rough draft of your render 
 
 Normal: Creates a render with more quality than quick but 

less than advanced. 
 

 Advanced: Takes the longest time to render but is 
rendered in the highest quality giving you better 
photorealistic images. 
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o Use the “Save Capture” command to save the rendering as an image. 
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3. Learn How to Create and Publish Conceptual Models 

3.1 INSERTING AND CALIBRATING CONCEPTUAL IMAGES  

Make sure you have 2 x 2D sketched images. This could be in any picture format. It could be 2 

pictures that you have taken from your model, scanned or sketched images. The best application 

to create these sketched images is Autodesk Sketchbook.  

3.1.1 Steps on how to insert the image and its settings: 

1. To insert these images, go to the “file” icon and select new design, this is to start a new 

canvas. 

2. Select “Insert attached canvas” – this allows you to bring in an image attached to a plane. 

 
3. Select a plane where you would like to add the image to. 

4. Browse for the image that you would like to use. 

5. If the image comes in very small or big, scale it bigger or smaller. 

6. Set the “Canvas Opacity” – This will allow you to 

see through the image. A good value is 50, it is 

enough for you to still see the image so that you 

can model it. 

7. “Display Through” – If “display through is selected, 

it allows the image to display through any 

geometry that might be in front of the image. 

8. “Selectable” – Keep selectable turned off. This will 

prevent you from selecting the image by accident 

when you create or edit your geometry 

9. You can choose if you want to flip your image 

horizontal or vertical. 

 

10. Once all the settings are good, select ok and view the image. 
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In your model browser you will get “canvases”. Next to the different 

canvases you will see a light bulb that will allow you to toggle the different 

images on/off. You can also make sure that the image is the correct size 

by using the “calibrate” tool. This allows you to select two points on your 

image and type in the correct value that it should be, scaling your image to 

the correct size. Repeat this process for the other images. 

 

 

Once you have added the images, this is a good point to “Save” the file. 

When you select save for the first time, you will be prompted to enter a name and a project to save 

it in. Saving after the first save will just save a new version, just like any other application. 

 

Now that you have all your images set up, start creating your geometry. 

Create a model using a concept image: 
1. Download the images from the “Additional Materials” 
2. Select “Attached Canvas” from the “Insert” dropdown 
3. Select the YZ plane 
4. Start the “Select Image” command and select the “Razor-Side” image. Set the “Canvas 

Opacity” to 50. Select the “Display Through” option. 
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5. Repeat step 4 for the top view using the “Razor-Top” image. Change the Z Angle to 270. 

 
6. To size the canvas, right-click on the “Razor-Side” image in the browser and select 

“Calibrate”. Normally you would select two points on the image, in this case we are using 
the two corners of the image. Change the value to 200mm. 

 
7. Repeat step 6 for the top canvas. 
8. Start the “Create Form” command 
9. We could start with a Box and then Edit Form, but to speed things up, let’s use the Face 

command to trace out the part. 
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10.   Select 4 points to start moving from the end of the part towards the center.  

 
11.  Change the Mode to Edge so that we can use the last edge of the previous face as an 

edge for the next face.  Select the Edge and then the next two points for the new face.  

12. Trace faces across the part – approximately as shown. 

 
13. Right mouse button – Edit Form. 

 
 

14. Double click one of the faces to select all of the faces. 
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15. Hold the Alt key and drag to extrude the faces on one side.  

 
 

16. Then transform the faces and edges till they approximate the art. 

 
 

17.   Moving an edge. 
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18. Check from top and side.  Remember we are approximating art.  Toggle the Canvases on 

and off to compare. 

 
 

19.   Mirror Duplicate (with Weld) to create the other side.  Toggle the Canvases on/off to see 

your results. 
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20. Temporarily Hide the Canvases.  Make sure there is a line of symmetry across the part.  

Ctrl select these faces and right mouse button select Subdivide. 

 
21. From the Insert Mode select Exact.  Check the other side of the part.  . 

 
22. Ctrl select these edges and then right mouse button select Slide Edge and line up these 

edges with the images.  While we are at this step – notice the other edge editing options. 
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23. To create the indentation in this area Ctrl select these faces, select Edit Form and holding 

the Alt key Extrude the faces in slightly. 

 

 

24. Avoid creating creased edges (easier to see on the opposite mirrored side of the part 

while editing). 

25.   Select this vertex and right mouse button select Weld Vertices. 
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26. Select this vertex as the second selection. 

 
 

27.   While in the command, weld these two vertices too, selecting the inside vertex first and 

then the outside vertex. 

 
 

28. Create 2 new faces on the YZ plane approximately as shown. 
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29.   Alt extrude the faces. 

 
30.   Mirror – Duplicate (with Weld).  Notice that when we extruded the faces we have a 

second t-spline Body.  Hide the first Body. 

 
31. With the Edit Form tools adjust the t-spline body to use as a toolbody for cutting a hole in 

the first body. 

 
 

32. When satisfied – click Finish Form. 
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33. From the Modify tab select Combine and select the target and toolbody, set to Cut.  I 

almost always Keep Tools (Hide the toolbody when finished). 

 
34. Fillet the edges of the cut as desired.  

 
 

35. Start a new sketch on the YZ plane (with only this Canvas visible). 
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4. Share and Collaborate Designs 
Share your designs within the Fusion 360 application. 

4.1 Autodesk 360 

You can share and collaborate your design using Autodesk 360. In your Data Panel, select the 

“members” icon. This will allow you to add members to your design. You can invite them using their 

email address. Invited members will have access to view and collaborate on your design, they will 

have full access to all the design data in the active project. 

 

4.2 Share a Public Link 

You can share your design by sending the user/member a link to your project. 

 
 

Process: Go to the toolbar and select the “file” icon. Go 

to the “share” command and select “Share Public Link” 

This command will give you the option to share to URL 

as well as set the privacy settings for the URL. You can 

set the following settings: 
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 Allow item to be downloaded – This will allow the user you send the link to, to download the 

file and choose the format he wants to download his file in. 

 Require a password to access public link – This allows the designer to password protect his/her 

design. 

 

The user would have limited functionality and will only 

be able to zoom, pan, rotate and download (if the 

download option was selected). 

 

 

 

4.3 Share publically 

You can share your design using the Fusion 360 

app as well as directly on the Fusion 360 website. 

When you share your model from the Fusion 360 

design app you can choose to share your model on 

GrabCAD or the Fusion 360 Gallery.  

 

Process: Go to “Share to Fusion 360 Gallery”, a dialog 

box will appear. Choose if this is a “New Project” or an 

“Existing Project”. You can then choose if you want to 

add the 3D model to the gallery and choose the 

different thumbnails to include. From here you will 

enter the project information such as the project title, 

category, description, products that was used to 

create the model and tags to make it easy to search 

models. From there you can publish your model and 

find it in the Fusion 360 Gallery. 
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To publish your design directly on the Fusion 360 website, follow this link: 

https://fusion360.autodesk.com/projects/recent 

Go to “Create new project” and add all the project information and publish the project. 

 

https://fusion360.autodesk.com/projects/recent

